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1 General 
Various software products for “Computer-Aided Design” (abbrev. CAD) are available 
on the market. These are characterised by different specifications and areas of 
application. The best-known CAD application is probably “AutoCAD” from Autodesk.  
 
This is a CAD application that primarily enables 2D drawing, i.e. it replaces the 
classic drawing sheet. 3D functions were added in “toolsets”. 
Other well-known CAD programmes are1:  

Name Manufacturer Areas of application Link 
Catia Dassault Systems Aerospace technology, 

automotive 
manufacturing, 
mechanical 
engineering, large-
scale enterprises 

http://www.3ds.com/
de/produkte-und-
services/catia/ 
 

Fusion360 Autodesk Product design, 
toolmaking, smaller 
companies 

https://www.autodesk
.de/products/fusion-
360/overview 
 

Inventor Autodesk Product design, 
toolmaking, 
architecture, medium 
enterprises 

https://www.autodesk
.de/products/inventor
/overview?us_oa=dot
com-
us&us_si=3b99b45b-
f3a0-4ec7-9bb8-
e2370ab4276d&us_s
t=inventor&us_pt=IN
VNTOR 
 

Rhino(ceros 3D) Robert McNeel & 
Associates 
 

Product design, 
architecture, small and 
medium enterprises 

https://www.rhino3d.
com/ 
 

Solid Edge Siemens Mechanical 
engineering, plant 
engineering, 
toolmaking, large-
scale enterprises 

http://www.plm.auto
mation.siemens.com/
de_de/products/veloc
ity/solidedge/ 
 

Solid Woks Dassault Systems Mechanical 
engineering, plant 
engineering, 
toolmaking, large-
scale enterprises 

http://www.solidwork
s.de/ 
 

 
The decision to use Autodesk Fusion360 for tactile teaching media was based on the 
following reasons: 

1. Good price/performance ratio, available school licences 
2. Comprehensive support of 3D constructions 
3. Easy to learn, available online tutorials 

 

 
1 List in alphabetical order without reference to market shares 
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The software Autodesk Fusion360 is a very comprehensive CAD application that 
allows the creation of very complex technical constructions. In fact, only a fragment of 
Fusion360’s functionality is required for the production of tactile teaching materials. 
These basic functions will be covered here and be quite sufficient to create tactile 
location maps and simple tactile models for technology or science lessons. 
 
Since updates to the software are released several times a year, it is possible that 
the graphical user interface or the menus may change and no longer be identical to 
the illustrations listed in this manual. 
 
For readers who want to explore Fusion360 in more detail, the video tutorials from 
Autodesk are recommended. These are available at: 
https://help.autodesk.com/view/fusion360/ENU/courses/AP-GET-STARTED-
OVERVIEW 
Alternatively, you can scan the following QR Code with your smartphone. 

 
 
For most trainers working in educational institutions for people with visual impairments, 
the handling of a CAD programme is rather unknown. The large range of functions as 
well as the technical application background may even seem daunting for newcomers. 
However, the model shown below proves that Fusion360 is easy to use. After only 30 
minutes of instruction in Fusion 360, a 16-year-old student constructed this model on 
his own in 18 hours. The model was based exclusively on photos and drawings from 
the internet. The procedures described in this tutorial were used for realisation of this 
model. 

Figure 1 Building designed with Fusion360  
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2 Autodesk Fusion360: Download and Installation 
Autodesk Fusion360 is available free of charge for private users and non-commercial 
use. However, this version is severely limited in functionality. For educational 
organisations, an educational version is available that offers the full range of 
functions. All that is necessary for this is to register. At this point, it is recommended 
to use this full version. All descriptions and illustrations are based on the full version. 
 
Currently (in August 2021), Fusion360 can be obtained as a single-user or campus 
licence via download. A stable internet connection is required for installation. The 
licence version is checked online both during installation and each time the 
programme is started. Without internet connection during the installation process, 
Fusion360 cannot be installed. In case there is no internet connection after the 
installation, you can work offline for a limited period of time. 
 
Fusion360 is cloud-based. Although one can save all constructions locally, the 
intended storage method is the cloud. Each administrator can create a folder with 
subfolders for their courses, which means that editing is thus also possible from other 
computers. There are even apps for smartphones and tablets. 
 
Autodesk prescribes a minimum technical configuration for the operation of 
Fusion360. This can be found at: https://knowledge.autodesk.com/support/fusion-
360/troubleshooting/caas/sfdcarticles/sfdcarticles/System-requirements-for-
Autodesk-Fusion-360.html 
 
However, to ensure that Fusion360 works without problems, the computer used 
should have a 3D-capable graphics card with at least 4 GByte VRAM and a working 
memory of 12 GByte. This allows changes of perspective without any delay. 

3 First steps in Fusion360 
After installation, Fusion can be opened either via the icon on the desktop or the start 
menu. The first time Fusion is started after installation, the user must enter the 
Autodesk ID and password. Fusion360 cannot be started without this identification. It 
is therefore necessary that this data is available to the users or that the login is 
carried out by the administrator. After the successful start, the working window 
opens. The largest area of the window is the Working Area. This area represents the 
virtual drawing sheet that can be moved, rotated and enlarged as desired. 
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3.1 Graphical User Interface and Essential Menus 

Figure 2 Graphical User Interface of Fusion360 
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The different controls have been highlighted in different colours for the purposes of 
explanation. These are outlined in the following chapters as far as they are relevant 
for the construction of tactile materials. 
 

�  Quick Access Toolbar (purple) 

�  Ribbon (green) 

�  Browser bar (yellow) 

�  View cube (red) 

�  Navigation bar and view settings (blue) 

�  Timeline (orange) 
 
3.1.1 The Quick Access Toolbar 
The quick access toolbar contains all the functions for saving, exporting and loading 
files. 

Figure 3 Quick Access Toolbar 

The quick access toolbar contains the following functions from left to right: 
 
- Group data  
- File functions  
- Save (the actual construction)  
- Undo last command  
- Repeat last command  
 
The last three of the above-mentioned functions are self-explanatory.  
 
3.1.1.1 Group data 

If you save your own designs in the cloud, this function offers the quickest and 
easiest access to the designs saved there. 
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By activating the button , the last used project folder appears. The subfolders or 
constructions created are displayed here. You can open them by double-clicking the 
left mouse key. You can then close the view by deactivating the button or by clicking 
on the X symbol in the group data window. 

Figure 4 Open group data window with available constructions 
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3.1.1.2 File function 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5 Menu of the “File” function 

 
This menu is divided into four blocks arranged one below the other.  
New constructions can be started in the first block. For our purposes, “New Design” is 
appropriate. 
 
In the second block, the functions “Save (as)” and “Export” are relevant. 
The “Save” function allows the file to be saved in the cloud. If no file name has been 
assigned yet, a dialogue window opens that prompts you to enter the file name and 

the folder in the cloud. To see the entire dialogue window, the button  in the right-
hand area should be activated. 
The folders created under the username in the Fusion360 Cloud are displayed here. 
These folders are called “project” and can in turn be subdivided with several folders. 
 
Corresponding buttons can be used to create new projects at the top level and also 
to create new folders. 
 
An option to save to a local data carrier is not offered in this function. 
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Figure 6 “Save” window 

The function “Save” (the actual construction) in the quick access bar is identical to 
the function described above. 
 
The “Export” function enables a file to be saved locally on a data carrier. The window 
of this function is similar to the window shown in 6Figure 6 “Save” window. In this 
case, a reference is made to a local data carrier in the destination folder.  
 
The other functions in the remaining two blocks are less relevant for our purposes. 
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3.1.2 Ribbon 
The Ribbon is the most powerful tool because it contains all the elements required for 
construction. When starting Fusion360, make sure that the menu item “Solid” is 
activated. If this is the case, the toolbox corresponds to the following illustration. 
 

Figure 7 Representation of the ribbon in the “Solid” setting 

The Ribbon is divided into several sections, which are subdivided by a grey dividing 
line. The most important areas are “Create” and “Modify”. Above these names, you 
can find icons with frequently used functions. The menus can be opened by clicking 
on the small drop-down triangle to the right of the section name. 
 
The functions are described in more detail in the following chapter. 
 
3.1.3 Browser Bar 
The Browser bar provides an overview of the created elements within the design. 
Thus, this browser palette fulfils a similar function to the Explorer in Windows. 
Especially for complex constructions with many different elements, this function offers 
a quick overview. In addition, by marking an element, it can be edited directly. 

Figure 8 Browser bar. Left: New worksheet. Right: Two elements created 
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3.1.4 View Cube 
The View Cube allows for quick changes of view on all axes. The view change allows 
a change in 90° and 45° steps. For the 90° steps, simply click on the full surfaces 
such as “Front” or “Top”. For smaller changes click on the corresponding edges or 
corners. As soon as the mouse pointer is on a selectable position, the view area is 
displayed in blue. 
 

Figure 9 Changing views with the View Cube 

 
Next to the View Cube, there are further symbols. The house symbol takes you to the 
“Home” view. Here the view is aligned with the centre of the construction and an 
diagonal view is provided. With the arrows on the upper right side, the view can be 
tilted by 90°. 
 
3.1.5 Navigation Bar and View Settings 
In this toolbar, alterations can be made to the views. The most important buttons are 
used for free rotation of the working area and for shifting. 

The “Orbit” button  activates the free rotation function of the working area. By 
clicking and holding the left mouse button, you can rotate the working area as 
desired. In this mode, the mouse pointer changes and can only be used for the 
rotation function. To exit this mode, press the ESC key. 
 

Moving the working area using the “Pan” button  functions in a similar way. By 
clicking and holding the left mouse button, the working area can be moved as 
desired. To exit this mode, also press the ESC key. 
 
To return to the centre of the workspace, activate the “Home” symbol in the view 
cube. 
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3.1.6 Timeline 
The Timeline is a very important function that allows changes and corrections in the 
design without having to delete and completely redraw. In the Timeline, each 
construction step is documented and displayed symbolically. 

Figure 10 Timeline in Fusion360 

If you want to make changes in the construction, you can jump to the corresponding 
construction step with the slider and change it. The constructions following this 
construction step will change accordingly. 
 
In addition, the Timeline is a good methodological tool for coaching Fusion360. By 
moving the timeline step by step, a student can follow the steps in a construction. 
This facilitates the creation of Fusion360 lessons that can be followed by students 
through the timeline. 
 
 

4 Designing with Fusion360 
With CAD programmes, the user must keep in mind that they are designing in a 
three-dimensional space. The positioning of drawing and construction elements 
depends on the viewing perspective. With a classic drawing board, you look at and 
draw the drawing from above. With a CAD programme, however, it is possible to 
draw from different perspectives. For example, if the viewing angle in the View Cube 
is “Front”, an element is drawn from the front, i.e. as if it was standing on the drawing 
board. Therefore, it is recommended to choose the “Top” view. 
 
4.1 The Beginning: Drawing of Sketches 
Constructions usually begin with a two-dimensional drawing. These are created using 

the “Sketch” function. To do this, either select the button  in the toolbox or open 
the “Create” menu by clicking on the small black drop-down triangle. 
Here, you select the function “Create Sketch”. 

Figure 11 “Create Sketch” menu  

After this selection, nothing seems to happen at first. However, if you look closely at 
the workspace, you will see that a square is displayed in the middle of the screen. 
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This is the construction plane. Click on this construction plane to create the sketch 
horizontally to the Z-axis.  

Figure 12 Construction lpane 

Subsequently, the icons in the toolbox change and the most frequently used 
sketching tools are listed. Again, it is also possible to open the menu by clicking on 
the triangle next to the “Create” selection. 

Figure 13 Toolbox and “Sketch” menu 

There are several sketch elements in the sketch menu. The most popular ones are: 
 
- Line 
- Circle 
- Rectangle 
- Text 
- Spline 
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A sketch can consist of only one of the upper elements, or a combination of multiple 
elements. As an example, let's take a building floor plan. This is where all lines, 
circular and rectangular elements can be created separately as several sketches or 
as a common sketch. In the example below, all drawing elements belong to one 
sketch. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14 Example floor plan. All elements as a single sketch 

The decision whether to create all elements as separate or as a unique sketch 
depends on the degree of the following operations. If, in the example above, the 
entire floor plan has to be moved, rotated or scaled, it is better that all elements 
belong to one sketch. If individual elements need to be changed, it is easier to create 
them as a separate sketch. 
 
To create a sketch, activate the corresponding button or select the menu item. 
Frequently used sketching tools can also be accessed directly with a shortcut. 
 
4.1.1 Circle, Rectangle and Line 
Circle   c  
Rectangle  r  
Line   l  
 
After selecting the desired sketch tool, the mouse pointer changes to a crosshair 
cursor. Position this crosshair cursor at the desired location and drag it while holding 
down the left mouse button until the desired sketch size is reached. When drawing 
the sketch, a text field opens. Here you can enter the desired size in millimetres. 
Decimal places must be entered using the decimal point. 
 
For rectangles and squares, you can switch between the text fields using the tab key. 
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Figure 15 Sketch tool with text field for size specification 

Once the sketch has been completed, it must be finalised by clicking “Finish sketch”. 
This function is located as an icon on the far right of the toolbox or in the “Sketch 
Palette” dialogue window. 
 
More complex shapes, such as floor plans, can be created using the “Line” function. 
This function also allows parameters to be entered via two text fields. One parameter 
is the length, the other is the angular dimension to the selected drawing level. By 
means of a single left mouse click, the line is drawn from a starting point to the end 
point. Subsequently, another line can be drawn starting from the last end point. The 
line function is completed by either pressing the enter key or double clicking the left 
mouse key. 
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Figure 16 Trapezoid drawn using the line function 

Drawing lines in particular requires some skill in using the mouse. A hasty mouse 
click immediately results in an unwanted line. The easiest way to remove a line is to 
use the  “Undo command” symbol in the quick access toolbar. 
 
4.1.2 Polygon, Spline and Text 
These three tools enable the creation of more complex shapes as well as the design 
of text surfaces. 
 
With the “Polygone” function, polygonal building outlines can be created very easily. 
The “Spline” function allows the creation of curved lines or contours. With the “Text” 
function, three-dimensional text elements can be created. 
 
Polygons are created by specifying the diameter and the number of corners. In order 
to be able to draw a polygon, the command “Create Sketch” must first be selected 
again. After clicking on the construction plane, the first option “Circumscribed 
Polygon” is selected from the Sketch menu. Subsequently, select the centre of the 
polygon in the construction area and draw the polygon by holding down the left 
mouse button. Here, too, the diameter and the number of corners can be entered 
using text fields. 
 

Figure 17 Circumscribed polygon 

Once you have drawn the polygon, do not forget to press the “Finish Sketch” button 
to exit sketch mode. 
 
The “Line” function can be used to draw a variety of floor plans. However, this 
function is not suitable for drawing round shapes. Instead, the “Spline” function is 
much better suited for this. After selecting the "Spline" function, you can use the 
mouse pointer to set various points of progression. Fusion360 connects these points 
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with an arc according to the position of the previous point. The shorter the distances 
between the points, the smaller the radius between them. 
 
 
After completing the spline, press the enter key to exit the input mode. You can now 
see the line together with all the black points created. On both sides of each of these 
black points are green points connected by a green line. This is an angular curve that 
allows you to change the angle of the curve defined by the black point. By keeping 
the left mouse button pressed, the green points can be moved. The arcs change 
accordingly. 
 
 
 
 
 
 
 
 
 
 
 

Figure 18 Spline sketch. Left: Spline sketch source. Right: Arc bottom left changed 

To change arcs in the spline, the black points can be moved by holding down the left 
mouse button. 
 
The sketch function “Text” allows you to insert text elements. Various fonts and text 
attributes are available. However, not all fonts and attributes are suitable for 3D 
printing as they are too fragile and do not allow for stable printing. Yet, sans-serif 
fonts such as Arial and Verdana are suitable, provided you do not go below a 
character size of 6mm. If the character size is too small, punctuation marks and 
umlaut dots in particular are too fine to withstand even light mechanical stress. 
 
Inserting the text is very simple. After opening the sketch mode and selecting the text 
function, you can select the text orientation. Two icons are displayed for this. By 

default, a straight text alignment is selected with the first icon . However, it is 
possible to select a winding or angled text orientation with the second button . For 
the latter, however, a circle, spline or rectangle must be available as the required 
gradient path. In this description we will only deal with the straight orientation. 
 
After selecting the orientation, draw a rectangle along the desired text position with 
the mouse. The left mouse button is used to mark the text position. 
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Figure 19 Text function and text positioning 

 
When placing the position frame, adherence to the exact dimensions is not relevant 
at first as the text can still be repositioned precisely afterwards. As a rule, the position 
frame is set from top left to bottom right with the mouse. 
 
The dialogue window for setting the text settings will open. This is based on the 
functions of text editors and is therefore easy to understand. 

Figure 20 Setup options for text 

The default “Sample Text” can be overwritten in the text field. Line breaks can be 
inserted by pressing the enter key. The box below allows you to select the font type. 
Below this is the option to select the typeface (bold or italic). For reasons of stability, 
italic fonts are only suitable for 3D printing non-functional models. 
 
The font height is automatically set to 10mm. However, another value can be 
entered. As already mentioned above, the height value should not be less than 6mm. 
 
After setting all options, click the “OK” button to complete the process. The editing 
area is now opened and the text can be repositioned with the mouse pointer. Finally, 
press the “Finish sketch” button. 
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4.1.3 Moving and copying sketches 
If a sketch needs to be moved, there are two methods for achieving this: 
1. Move after finishing the sketch 
2. Move in edit mode of the sketch 
 
1. Once the sketch is completed, all elements of the sketch to be moved have to be 
marked. This is done by clicking the mouse while holding down the shift key or by 
marking with a selection rectangle using the left mouse button. The last option is only 
possible, however, if two sketches do not overlap and only one of them is to be 
moved. 
 
 
 
 
 
 
 
 
 
 
Figure 21 Marking sketch elements. Left: By mouse clicking on the relevant lines. Right: Using 

a selection rectangle 

 
Once the elements have been marked, the sketch can be moved. To do this, select 
one of the lines by clicking on it with the left mouse button held down and move it to 
the desired position by moving the mouse. 
 

2. The editing mode also offers the option for the user to copy a sketch. In addition, 
moving can be done very precisely by entering the parameters. 

If the editing mode has been closed by clicking the “Finish sketch” button, it must be 
reactivated. To do this, activate the sketch in question in the browser palette by 
clicking on it with the mouse. Then, press the right mouse button to open the context 
menu as shown in Figure 22 Browser bar and context menu”. In this menu, select the 
option “Edit Sketch”. 
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Figure 22 Browser bar and context menu 

After opening the editing mode, the sketch to be moved must be marked as 
described in 1. However, the context menu can now be activated by hovering the 
mouse pointer over one of the lines of the sketch and clicking the right mouse button. 
This provides you with the option “Move/Copy”. 

Figure 23 Context menu in sketch editing mode 

This option can be selected via a mouse click and results in the “Move” widget now 
appearing on the sketch. Figure 24 depicts this widget containing two movement 
arrows and a small circle to change the angle of the sketch. By clicking on one of the 
arrows, the sketch can be moved by mouse along the axis. Moreover, a text field is 
opened. By entering a value, the sketch is moved in the direction of the arrow. If a 
negative value is inserted, the sketch is shifted in the opposite direction. This option 
is much more precise than moving the sketch with the mouse as it depends on the 
zoom factor. Sketches that have been zoomed out of can only be moved with little 
precision using the mouse. 
 
By clicking on the small circle that is located on an arc, you can rotate the sketch. 
Again, a text field is opened that allows you to enter an angle measure. 
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Figure 24 “Move” widget in the “Top” view 

The “Move” widget depends on the view mode of the sketch. In Figure 24 “Move” 
widget in the “Top” view), the view “Top” has been selected. This only permits 
movement with the arrows in the X and Y axes. However, if you select other views, 
i.e. “Front”, “Back”, “Left” or “Right” in the view cube, the sketch can also be moved 
along the Z axis. 
 
Copying a sketch can also be done via the context menu. Instead of selecting the 
“Move/Copy” function, simply choose “Copy”. Subsequently, move the mouse to the 
location where the copy is to be pasted. Click the right mouse button to open the 
context menu again and select “Paste”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 25 Paste mode after activating the “Paste” option in the context menu 

 
As shown in Figure 25, the “Move widget” allowing for a sketch to be moved is 
displayed. To finish the moving/copying process, press the “Finish Sketch” button. 
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4.1.4  “Offset” and “Trim” function 
There are two important functions in sketch mode that are particularly helpful when 
creating site maps and floor plans. 
 
Imagine you are drawing a winding road for a site map. You do this, of course, using 
the Spline and Line function. To draw the entire width of the road, however, you 
would have to draw an exact parallel line. To facilitate this process, you simply need 
to select the “Offset” function in the “Modify” toolbox. 
 
Once “Offset” has been activated, select the reference line using your mouse. A 
dialogue box with a text field and a red offset line will appear. 

Figure 26 “Offset” function after having selected a reference-line 

The distance between the two lines can be entered in the text field. A negative value 
relocates the red offset line to the opposite side of the drawn (blue) line. This function 
can also be performed with any other sketch element such as a square, circle or 
polygon. 
 
The distance between the two lines is entered in the text field. With a negative value 
you shift the offset line to the opposite side. This function can also be performed with 
any other sketch element such as square, circle or polygon. 
 
In the case of tactile site plans for buildings, it may happen that different sketch 
elements overlap if the floor plan is not solely in a rectangular shape. In such cases, 
the floor plan may consist of a combination of lines, squares, circles or polygons 
(see: Figure 27). Creating an offset for the entire outer wall of such a complex floor 
plan will not work because the offset function is only applicable to one sketch element 
at a time. 
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Figure 27 Example floor plan from several sketch elements 

It can thus be useful to delete disturbing or superfluous lines. This can be done with 
the “Trim” function in the “Modify” section of the toolbox. 
 
After activating this function, all you need to do is click on the lines to be deleted with 
the mouse. As soon as the mouse pointer is hovering over a deletable line, the line 
colour changes. To delete the selected line, click the left mouse button. 

Figure 28 “Trim” function and highlighted line 

 
This way, all superfluous lines can be deleted one after the other. To undo the 
deletion of a line, press the reverse button  or use the key combination Ctrl + Z. 
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4.2 Arrangement of Sketches 
Creating recurring elements on a circle while maintaining the same spacing would be 
very difficult to realise without the “Circular Pattern” function. In the example below, a 
clock face is to be created. Circles for the different hours are to be arranged on a 
circular line. To do this, one must first draw only one circle with the diameter of the 
circle line on which the clock numbers are to be arranged using the sketch function. 
Then, another circle the size of the clock numbers is drawn on the circle line. Other 
shapes could be chosen instead of a circle for the digits. Next, one selects the 
“Circular Pattern” function in the Sketch menu before completing the sketch. 
 
In the “Objects” line of the dialogue window of this function, select the circle for the 
hour digits with the left mouse button and click on the small circle. Then, for the 
“Centre Point” field, select the large circle of the sketch and subsequently enter the 
number “12” in the “Quantity” field. Immediately, you will see a preview of the sketch. 
Click on the “OK” button to complete the layout. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 29 “Circular Pattern” function 

 
The “Rectangular Pattern” function works in a similar way to the function described 
above. In this case, an arrangement can be made along the X and Y axis. The sketch 
to be arranged must be selected in the dialogue window. In addition, specify the 
direction, distance and number of duplications. 
  



 
 

The T4VIS In 3D project consortium* Agreement No.: 2020-1-DE02-KA202-007620 
Version 2 * 22-10 

- 27 - 

 

4.3 From a Sketch to a 3D Solid 
For this purpose the “Extrusion” function in the toolbox “Solid” is used. This function 
can also be activated with the key command “e”. After selecting the function, mark 
the sketch that is to be converted with the mouse. Note that only closed sketches 
(these have a light blue background) can be extruded. Further details can be 
selected in the “Extrusion” dialogue window. 
 

Figure 30 “Extrusion” dialogue window  

 

For the production of tactile learning materials, the default settings of this function are 
completely sufficient.  
 
After selecting the inner surface of the sketch with the mouse, the dialogue window 
expands to include two text fields. In the text field “Distance”, the height of the 
extrusion is to be indicated in millimetres. In the example shown in Figure 31, the 
sketch is extruded by 20mm. If a negative value is entered (e.g. “-20”), the extrusion 
takes place into the opposite direction.  
The solid has a grey shading that distinguishes it from a sketch. The “Taper Angle” 
function provides the solid with a funnel shape for positive angle values and a cone 
shape for negative values. However, this input function is less frequently used. 
 
The created elements are called “solids” in Fusion360. 
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Figure 31 “Extrusion” Dialogue 

 
As soon as a solid has been created, it is also visible in the left browser palette and 
consecutively numbered as solid 1, solid 2, etc. 
 
The “Extrusion” function can be used with any closed sketch as described above. 
Text can be transformed to solid in the same way. For the latter, the function first 
needs to be activated and then the desired letter is to be selected with the mouse. 
Again, the desired height of the solid to be created needs to be entered into the text 
field “Distance”. After selecting the “OK” button, the text sketches are transformed to 
several solids. Each character represents a separate solid and is also listed in the 
browser palette. 
 
4.4 Creating Solids Without the Sketch Function 
Fusion360 further offers the possibility to directly create complex solids. This way, 
cuboids and cylinders can also be created without having to draw a rectangle or 
circle first. 
 
The “Sphere” and “Torus” functions are particularly relevant in this regard and both 
very easy to use. Once the “Sphere” function has been activated, you only have to 
mark the position with the mouse and then enter the desired diameter. 
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Figure 32 “Sphere” function 

The “Torus” function allows for the creation of a solid that is very suitable for 
representing roundabouts. It would be time-consuming to construct such a solid using 
the sketch function. 
 

 
Figure 33 “Torus” function 

To construct such a solid, simply enter the inner diameter in the first text box and the 
thickness of the torus (i.e. torus diameter) in the second text box. Note that the inner 
diameter in the default setting corresponds to the diameter that runs through the 
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centre of the torus. To change the measuring point of the diameter, change the value 
in the “Position” field. 
 
4.5 Moving and Copying Solids 
Moving and copying solids is just as easy as it is for sketches. In the example shown 
in Figure 34, the sphere is to be moved to the top of the polyhedron. 

Figure 34 Moving solids with the motion widget 

The most convenient way to achieve this is to select the solid to be moved in the 
browser palette by clicking on it with the mouse. Just like it is the case for sketches, 
the movement widget then appears. Using the direction arrows, the selected solid 
can be moved in the corresponding direction with the mouse. In the example 
provided in Figure 34, the sphere can only be moved along the Z and X axes in the 
selected view. In order to position the sphere exactly in the centre of the top of the 
polyhedron, “Top” view must be selected in the View Cube. This allows the solid to 
be moved along the Y-axis. 
 
As is the case when moving sketches, a dialogue window pops up next to the 
movement widget, where the corresponding values can be entered manually. In order 
to copy the selected solid, tick the “Create Copy” check box in the lower part of this 
dialogue window. 
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Figure 35 Dialogue window “Move/Copy” 

4.6 Creating Solids with the “Revolve” and “Sweep” Functions 
Fusion360 offers other helpful functions to create solids from sketches. The 
“Revolve” and “Sweep” functions allow for the creation of solids from sketches that 
originate from a revolve axis or path. 
 
4.6.1  “Revolve” Function 
This function allows the simple creation of round solids that are rotated around an 
axis. In the example given below, a champagne glass is to be created. To do this, 
one must first create only one half of the glass using the “Line” sketch tool. 
Subsequently, the “Revolve” function in the toolbox in the “Create” menu needs to be 
applied. In the first step, mark the profile to be rotated. To do this, left click on the 
surface area of the sketch. In the next step, select the rotation axis around which the 
sketch is to rotate. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 36 “Revolve” function. Left: Selection of the profile. Right: Selection of the axis (red) 

 
Moreover, the axis also needs to be selected using the left mouse button. The angle 
of rotation can then be entered in the dialogue window. In the above example, the 
value remains 360°. 
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4.6.2 “Sweep” Function  
The “Sweep” function allows for the creation of curved, twisted or angled solids from 
at least two sketch elements. The starting point for this is usually the following: 
 

1. A line that serves as a directional path. 
2. A geometric shape arranged at right angles to the path. 

 
Figure 37 Elements available for the “Sweep” function 

The geometric shape can be extruded using the “Sweep” function in the direction of 
the line, the directional path. To do this, first, select the menu item “Create” from the 
toolbox and then, select the function “Sweep”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 38 Window of the “Sweep” function 
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5 Exercise: Floor plan 
The previously explained functions are completely sufficient to create a tactile room 
plan. The aim of this chapter is to outline how to create a tactile map of a conference 
room as shown in Figure 39. 

Figure 39 View of a conference room for the exercise 

With regard to carrying out the exercise, it must be noted that no emphasis needs to 
be placed on the exact scale of the floor plan, but rather on the application of the 
functions of Fusion360. 
 
The objective is to create a tactile site plan that shows blind visitors the location of 
the: 
- entrance doors, 
- tables and table arrangements, 
- pillars, 
- screen, and  
- lectern.  

Figure 40 Aim of the exercise: tactile floor plan 
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As a reference for the dimensions that are used, refer to the drawing in the appendix 
(chapter 12). 
 
5.1 Floor Plan and Base Plate 
The base plate on which the displayable elements are located is the basis for tactile 
site plans. In practice, the size of the site plan is often determined by the maximum 
size of the 3D printer. The larger the size of the 3D printer, the more details can be 
displayed on the tactile site plan. As a rule, tactile site plans produced in 3D printing 
also follow the principles of representation known from plans on swell paper or the 
thermoforming process. This is sufficient in most cases. However, the 3D printing 
process also offers the possibility of representing special elements in full and not just 
in plan. In this context, mobility trainers will also learn how to use the new possibilities 
to their advantage.  
 
In the present exercise, only the flat outline of the floor plan is to be created. 
 
The minimum thickness of the base plate should not be less than 2 mm to ensure 
sufficient stability. 
 
For this exercise, it is assumed that the 3D printer has a maximum size of 200x200 
mm. Therefore, a base area of 200x158mm was used for the base plate. To create it, 
select the “Sketch and Rectangle” function in Fusion360 and draw a rectangle with 
the dimensions 200x158 mm. 

Figure 41 Rectangle for the base plate 

Before finishing the sketch, select the “Offset” function in the toolbox under “Modify”. 
Here, choose an offset of 2mm, which is used to represent the walls. 
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Figure 42 Offset representing the walls 

The next step is to extrude the base plate and the offset of the walls. To be able to 
extrude the base plate by 2mm, select the “Extrusion” function in the toolbox in the 
application “Create”. Then, click on the inner square with the mouse and enter “2mm” 
for the extrusion height in the respective text field. 
 

Figure 43 2mm extrusion of the base plate 
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Proceed in the same way with the offset for the walls. After selecting the “Extrusion” 
function, left click on the frame around the base plate and enter “3mm” as the offset 
size. The wall now overlaps the base plate by 1mm. 
The next step is to create the cut-outs in the front wall for the two doors. As can be 
seen in Figure 39, there is a double door with a centre door jamb. To realise this in 
construction, first draw a sketch with two rectangles for the two door leaves. Enter 
“9mm” for the width of each door and “1mm” for the width of the jamb. 
 
To draw the cut-outs, select “Create sketch” from the toolbox. Then, click on the 
surface of the wall body at the edge of the base plate. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 44 Selecting the sketch level for doors 

This has the effect that the sketch is created at the height of the wall surface. To 
determine the centre of the base plate as well as the position of the door leaves, one 
can use the background grid. Next, the rectangles for the door leaves need to be 
drawn accordingly on the wall solid. The process is completed by activating the 
“Finish sketch” button. 

 
Figure 45 Grid for the positioning of the doors 

Once the sketch has been completed, select the “Extrusion” function again and, while 
holding down the CTRL key, select both newly added rectangles by pressing the left 
mouse button. 
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Figure 46 Extrusion with negative values for cutting solids 

In the text field (“Distance”), enter the negative extrusion value “-1mm”. In the 
selected view, you can now see a red area below the rectangles. Instead of saying 
“Join” or “New Solid”, the “Operation” field now contains “Cut”. This operation mode is 
always preset in Fusion360 whenever an extrusion extends into a solid. This means 
that the “Extrusion” function is also suitable for creating cut-outs. 

 

In the present example, lower the wall to the level of the floor plate. This creates the 
cut-out for the two door leaves. 
 
5.2 Pillars and Furniture 
Next, it is the aim to create the pillars, conference tables, screen, lectern and bistro 
tables. This can easily be done by means of the the solid functions “Box” and 
“Cylinder” in the “Create” menu. 
 
First, create the four pillars in the front area. To do so, select the function “Cylinder” 
and position the mouse on the base plate. With the left mouse button pressed, draw 
the diameter. Enter a diameter of 8mm and a height of 3mm in the dialogue window. 
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Figure 47 First pillar created using the “Cylinder” function, 8mm diameter, 3mm height 

Next, move the pillar to the desired position. To do so, use the grid in the background 
as a guide. Select the pillar in the browser bar by left-clicking. Then, activate the 
context menu with the right mouse button. There, select the option “Move/Copy”. By 
means of the appearing move widget, drag the pillar to the right by clicking on the 
arrow pointing to the right.  
 

 
Figure 48 Moving the pillar with the “Move” widget 

You can either move the object with the mouse or by entering a value for the X axis 
in the dialogue window. After moving the first pillar to the correct position, you can 
repeat the previous step three more times to create the remaining three pillars. 
Alternatively, use the “Copy” function. This is an easier option given that you do not 
have to enter the size of the column three times. To copy an element, select the body 
of the pillar again with the mouse via the browser palette as described above. Again, 
activate the context menu using the right mouse button and select “Move/Copy”. 
Then, however, tick the check box “Create Copy” and enter “45mm” in the “X 
Distance” field to move the element by 45mm on the X axis. 
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This way, a copy of the pillar is created and positioned 45mm to the right of the 
original solid. 

 
Figure 49 Copying a solid and simultaneously moving it  

Repeat this process two more times for all four columns to have been created. 
 
Next, create the 18 conference tables. For this step, proceed in the same way as 
described above. First, create a table with the “Box” function and then copy it. 
 
After activating the “Box” function, position the mouse below the first column and 
draw a rectangle with the dimensions 10x25mm. Set the height to 1mm. Regarding 
the “Operation” field, make sure that the option “New Body” has been chosen. 
Complete the process by pressing “OK”. 

 
Figure 50 Table created using the “Box” function 

Now, copy and move this table several times. In the above example, first copy the 
table once and move it downwards. Then, repeat this a second time to create the left 
row of 3 tables. 
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To do this, left click on the table in the browser palette. It should be the last solid in 
the list. Activate the context menu by pressing the right mouse button, and select 
“Move/Copy” again. Here, make sure to tick the check box “Create Copy” and enter 
“30mm” as value for moving the object on the Z axis. 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 51 Copying the first table on Z axis 

 
Repeat this process with the second table. This gives you the first row of tables. 
Then, copy the entire row and move it to the right to obtain the first table block. To do 
this, select the three tables in the browser palette at the same time by left-clicking on 
the last three entries “Body...” while holding down the shift key. The selected 
elements will be highlighted in blue. Once again, activate the context menu using the 
right mouse button and tick the check box “Create Copy”. Move the table group on 
the X axis by 20mm. 
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Figure 52 Copying multiple solids 

Then, you can copy and move the entire block by selecting all six tables, copying 
them and moving them on the X axis. Enter “54mm” as the value for moving the 
tables. The second block should now appear. Repeat this process to create the third 
block as well. 
 
Finally, the screen and the lectern need to be created. Again, select the “Box” 
function to create the screen as well as the tables by entering the following values: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 53 Designing the screen 

 
Create the lectern in the same way using the following settings: 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 54 Designing the lectern 
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The bistro tables are created in the same way as the table groups. First, draw one of 
the tables. Then, copy it twice and move it 47mm to the right. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 55 Data of bistro tables 

 
5.3 Combining the Solids 
The elements arranged on the base plate have each been created as a “New Body”, 
which allows for them to be copied. Accordingly, 28 bodies should be listed in your 
browser bar. In order to export the created model as an STL file, you need to 
combine the bodies. For this, use the “Modify” menu from the tool palette. Open the 
menu by clicking on the triangle and then select the “Combine” function. The 
dialogue window appears next to the floor plan. 
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Figure 56 “Combine” function 

In the “Target Body” field of the dialogue window, select the solid body into which the 
other bodies are to be integrated. To do this, left-click on the base plate – you will 
then see that phrase “1 selected” will appear in the “Target Body” line. The target 
bodies are selected in this line by left-clicking on all the elements on the base plate. 
The selected elements are displayed in blue and the number of selected bodies in 
the line “Tool bodies” is increased accordingly. Selecting tool bodies can also be 
done via the browser palette. 
 
Once all elements have been selected, the construction should look as shown below: 
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Figure 57 All target and tool solids selected 

 
By pressing the “OK” button, the selected bodies are united. Only one body should 
then be visible in the browser palette. However, in case there are still several bodies 
listed, these bodies have either not been selected or have not been combined 
because they are not connected. For example, there could be a gap between two 
bodies. This must be checked from different perspectives and, if necessary, a body 
must be repositioned accordingly by using the “Move/Copy” function. 
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6 Creating STL files  
Creating STL files from a construction in Fusion360is relatively easy. However, it is 
important that the solid to be converted is as combined as possible. If it consists of 
several, non-combined solids, errors may occur in the STL file. Moreover, it could 
happen that individual solids are not exported.  
 
The model presented in chapter 5 fulfils the necessary requirements Unless it has 
already been done, load the file into Fusion360. Once the construction is loaded, 
select “Tools” from the menu in the toolbox. This will cause the display to change. 
Then, select the “3D Print” function from the “Make” menu. 
 
 
 
 
 
 
 
 

Figure 58 “3D Print” function in the “Make” menu 

 
A new dialogue box appears. In case the check box “Send to 3D Print Utility” is 
activated, deactivate this function. Then, left click on the floor plan. This results in an 
altered display of the item and the construction is shown as a mesh. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 59 “3D Print” function after selecting the relevant solid 

Press the “OK” button and then enter the file name and storage location for the STL 
file. 
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7 Creating Tactile Site Maps from Graphics 
In Fusion360 it is further possible to include graphics, such as floor plans or photos, 
as a basis for the construction of site maps. In principle, a graphic is used as a 
template for tracing with the sketch function. 
 
As an example, the conference room floor plan presented in chapter 5 is to be 
integrated into Fusion360 and traced. 
 
First, draw a rectangle in a new project that roughly corresponds to the size of the 
floor plan. In the present example, the rectangle has a size of 200x158mm. After 
creating the rectangle, close the sketch using the “Finish sketch” button. 
 
Next, select the menu item “Insert” from the toolbox. There, select the “Canvas” 
function. A data window will pop up. Select the source directory containing the 
graphic of the floor plan. You will then see the working area of Fusion360 appear 
together with a dialogue window. The first field contains the file name of the floor plan 
graphic you have just selected. Now, left click on the rectangle you have just drawn 
to let Fusion360 know that a graphic should appear at the respective location. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 60 Selection window for the canvas area 

The selected graphic is then opened in the selected canvas area. In the dialogue 
window that appears, detailed adjustments can be made to the positioning and 
transparency of the graphic. The insertion process is completed by pressing “OK”. 
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Figure 61 Adjustments for the inserted graphic 

 
Once the graphic has been inserted, trace the floor plan with the “Sketch” function. 
Using the functions “Extrusion” and “Solid” described above, a tactile location map 
can be produced. 
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8 Creating Tactile Braille Models 
In Fusion360, it is possible to create solids with Braille. However, this requires a 
chargeable add-in from the Autodesk Store. To install this add-in, select the “Tools” 
menu from the toolbox. In the menu bar, select the “Add-Ins” function and click on 
“Fusion360 App Store”. 

Figure 62 “Add-Ins” feature 

In the Fusion360 App Store, enter the word “braille” in the search field. Thanks to 
autocorrection, the available add-in “Braille Creator” will be added automatically. Left-
click on this mentioned add-in. This will transfer you to a page containing a 
description of the add-in. Currently (September 2022) this addin costs 2.99 US$ and 
can only be obtained for Microsoft Windows operated computers. 
 
 
 
 

 
 
 
 
 
 
 

Figure 63 Add-In Store with “Braille Creator” App 

After purchasing the full version or selecting the 30-day trial version, you will receive 
an installation file for download. Close Fusion360 before starting the installation 
process.  
 
Note: This Add-in was updated in July 2022, after the source version no longer 
worked after an update of Fusion360. Hence, it might be necessary to download the 
new version from the Autodesk app store and repeat the installation process. To 
facilitate this process, save the Braille Creator installation file on a data medium. 
The Braille Creator supports Unified English Braille and meanwhile French and 
Scandinavian letters. Special characters, country-specific characters and umlauts 
from other languages are not supported yet. The generated braille characters are 
created in the standard dimensions. 
 
To use the Braille Creator, simply press the “s” key to open the Model Toolbox. Enter 
the letters “br” and the autocorrection will immediately open the available add-ins 
containing this combination of letters. 
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Figure 64 Model toolbox after pressing the “s” key 

Activate the Braille Creator with the mouse. This will open a new dialogue window. 

Figure 65 Braille Creator window 

Enter the desired text in the respective lines. To generate the braille and insert it into 
Fusion360, press “OK” button. This process may take a few moments as the Add-in 
needs to perform complex operations to generate the braille dots. The text provided 
is inserted in Fusion360as a plate and forms a solid that can be copied or moved the 
same way other solids can be move and copied as well. 
 
 
 
 
 
 
 
 

Figure 66 Generated braille and display in the browser bar 
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9 Editing STL files 
Solids from mesh files in STL or OBJ format can be processed with Fusion360 with 
certain restrictions. This can be useful if only one STL or OBJ file is available, and the 
contained bodies are to be changed. The problem, however, is that you are dealing 
with a solid consisting of a mesh of polygons. A simple cuboid in a mesh file 
comprises many interconnected polygons. Without conversion, these files cannot be 
edited. 
 
Note: For large mesh objects with over 30,000 polygons, editing with Fusion360 can 
be problematic. 
 
The aim of the present example is to change a site plan of the Institut Rittmeyer, 
which was created with Touch Mapper  
(https://touch-mapper.org/en/area?map=B3f149e6b9b8ac55 ). 
 
The site plan is already available as an STL file on a data medium. 
 
To import the file, select the “Insert” menu from the toolbox. Then, select the 
submenu “Insert Mesh”.  
 
This forwards you to a Windows window for opening files. There, select the relevant 
file. The mesh body now appears in Fusion360 and is displayed in the browser 
palette under the heading “Body” as a mesh body. 

Figure 67 Inserted mesh body and view in the browser bar 

As depicted in Figure 67, the paths are shown as narrow cuboids. Delete these 
cuboids between the main buildings as well as the cone on the roof of the central 
building. 
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To change network files in Fusion360, the corresponding functions must be selected.  
 
If only individual elements of the mesh file are to be deleted, separate them. 
However, if bodies need to be added to the mesh body or further changes are 
required, the mesh body must be converted. 
 
To do so, use the “Mesh” menu from the toolbox. 
 
9.1 Removing Mesh Elements 
To delete the paths, first select the “Mesh” menu. In the modified toolbox, select the 
“Modify” menu and subsequently select the “Separate” function. 

Figure 68 “Modify” menu in the “Mesh” main menu 

 
Figure 69 “Separate” window 

Left-click on a surface of the base plate of the mesh body to select it as the body to 
be separated.  
After pressing “OK”, the net body is displayed in different colours. 
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Figure 70 Display of the mesh body after separation 

 
Now it is possible to select the individual mesh bodies by left-clicking. Once this has 
been done, open the context menu using the right mouse button. By selecting the 
function “Remove”, the selected element is deleted. 

Figure 71 “Remove” function in the context menu after selecting an element 

In the example shown in Figure 71, the street element located between the menu 
items “Undo” and “Redo” was selected. Proceed in the same way with the remaining 
street elements. Then, select the cone on the roof and remove it using the “Remove” 
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function from the context menu. Finally, you have a mesh body without street 
elements in the centre. 
 

 
Figure 72 Mesh body with deleted elements 

In order to print the altered mesh body, you first have to combine all the mesh 
elements again. To do so, select the “Combine” function form the “Modify” menu and 
select “Combine”. A dialogue window similar to the one described in Chapter 5.3. will 
appear. There, select the target body using the mouse: Left-click on the base plate 
and select all the other elements – one after the other – as “Tool bodies”. To combine 
the mesh body, press the “OK” button. 
 
Using the “Export” menu in the toolbox, you initiate the same process for producing 
an STL file as shown in Figure 58 “3D Print” function in the “Make” menu. This will 
create a new STL file that can be prepared for printing with the slicer. 
 
9.2 Editing Mesh Elements 
In order to integrate a mesh element into one’s own construction or to connect 
additional solids to it, the mesh needs to be converted first. Once again, select the 
submenu “Modify” from the main menu “Mesh”. Then, select the “Convert Mesh” 
function. 
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Figure 73 “Convert Mesh” function 

After activation, a dialogue window pops up. Select an area of the network body by 
left-clicking on it. Press “OK” to start the conversion. 

Figure 74 “Convert Mesh” window  

 
Once the conversion is complete, the solids are no longer displayed as individual 
solids but in the structure of the polygons. This can be very confusing for further 
editing. 
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Figure 75 Converted mesh 

Nonetheless, further processing is carried out as described in chapter 4.3. 
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12 Appendix 


